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Organic Manures Inventory and Storage

The Nitrate Vulnerable Zone (NVZ) regulations establish a number of rules about the storage of organic
manures on farms in Scotland that are in a NVZ.

For details of these regulations, see the NVZ Guidance available from the PLANET Library.

The PLANET Organic Manures Inventory and Storage module calculates the monthly production of
organic manures on your farm based on details of the livestock on the holding, and allowing for any
imports and exports of manure. It calculates the NVZ minimum storage requirement and the approximate
nutrient content of the manures.

The PLANET Existing Manure Store Capacity module calculates the capacity of your existing manure
stores.

Important

The information supplied in the PLANET software is for guidance purposes only and is not intended to
fully substitute for professional agricultural advice. The specific statutory elements concerning water and
nitrates are set out in the relevant national legislation and you should refer to this legislation to find out
exactly what you must do. The nutrient recommendations provided by PLANET are in line with national
industry standard guidance. If in doubt, farmers should seek help from a qualified adviser.

The user is responsible for ensuring the accuracy and completeness of all data entered and used by
PLANET, and for any commercial decisions taken based on any of the PLANET recommendations or
other outputs of this software. Use of the PLANET software is subject to the terms and conditions of the
PLANET User Licence.

PLANET v3 has been developed by ADAS and SRUC with funding and support from Defra and the
Scottish Government. The software is maintained by ADAS. Support is provided by ADAS (in England
and Wales) and SRUC (in Scotland). For further information, visit www.planet4farmers.co.uk or ring the
PLANET Helpline on 08456 023864.
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Getting started

To use this module, you must first create a new farm file and as a minimum, enter the Farm name, STD
code and Postcode in the Farm Details tab. You do not need to enter any other information. You will then
be prompted to give the file a name and to save it.

To use the module, select the Organic Manures Inventory and Storage icon h from the task bar at the
top of the screen, or select Organic Manures Inventory and Storage from the View menu.

The module will appear with six tabs (screens).
e Manure Stores
e Livestock Details
e Wash Water
e Imports and Exports
e Inventory

e NVZ Minimum Storage

You will need to enter information into each relevant tab. The Inventory tab will then show you the
quantities, and approximate nutrient value (amounts and financial value) of the organic manures on the
holding. The NVZ Minimum Storage tab will show you the estimated minimum storage requirements in
order to comply with the NVZ rules. For further information, see NVZ Guidance available from the
PLANET library.

Further information to help with data entry is provided throughout PLANET by hovering over the column

header where there is a <+ button shown, or by clicking in any data entry cell and then pressing the F1

key.

The PLANET Helpline can be contacted on 08456 023864 but this Helpline will NOT give specific
technical advice on manure or fertiliser use for a specific farm or field crop.

Important. You can only save one set of data in this module. For instance, if you enter data for a
calendar year then this will be saved on your computer. However, if you then edit this data (e.g. for a
later calendar year) the original data will be overwritten and only the new data will be saved. Therefore, if
you wish to keep a permanent record of the PLANET calculation and report for a particular calendar
year, you should either print out a hard copy of the PLANET report before making any edits to the data,
or use the Save As function in the File menu to save each set of data as a separate Farm file which you
will need to name individually.
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Manure Stores tab

[ﬂPLAN[T - Organic Manures Inventory and Storage from October 2010
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1. Select the start year. Entries can be made for up to 12 months starting at October.

2. Enter the farmed area, making separate entries for that is inside and outside any NVZ.

3. Enter the capacity and surface area of existing Slurry stores, Dirty water stores and Solid manure
stores on an impermeable base or in poultry houses that are on the holding. If you wish, you can
use the PLANET module ‘Existing Manure Store Capacity’ to calculate the storage capacity of
individual stores.

4. Select Yes or No if there is any cattle, pig or poultry slurry storage facility located inside an NVZ
on your farm.

5. Enter the total area of Rainwater collection areas. If there are several individual areas, you will
need to work out the total of these areas and enter this value.

6. Enter the calendar year of the Inventory Period. The period is for 12 months starting in October
but you can calculate the inventory for any range of months you wish.

7. The annual Rainfall is generated automatically from the STD code that you entered when the

Farm details were set up. Go back to the Farm Details module - to change this if it is
incorrect.

8. If you wish, edit the default values of the Nutrient price (monetary value) of nitrogen, phosphate
and potash by entering either the pence/kg of nutrient or £/tonne of fertiliser product.

9. When you have entered all the required details, click on the Livestock Details tab.
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Livestock Details Tab

You will need to enter details for each month that you wish the inventory to cover. If you wish to calculate
an estimate of the NVZ minimum manure storage requirement then you must enter all required details
for October to March inclusive (for pigs and poultry), or October to February inclusive (for other livestock,
including cattle).

To expand or collapse information for a month, select the + or — to the left of the month name. To
Expand all months or Collapse all months, click the right hand mouse button and select the required
option, or go to the Tools menu at the top of the page.

Once you have entered Livestock details for one month, you can use the Data Entry Wizard to copy this
information to other selected months in the Livestock details and/or Wash water tabs.
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1. For each Month, enter the details of all livestock on the farm during the month. Always enter new
information in the top row for the month and press the return key to accept the row information.

2. Select the Livestock group and Livestock type for each type of livestock that you have on the
farm during the month. For each Livestock type, you will first have to select the appropriate
Livestock group (e.g. cattle), then select the Livestock type (e.g. 1 dairy cow, 6000-9000 litres
milk yield).

3. Enter the average Number of each livestock type that are on the farm for the whole month. If
livestock are on the farm for only part of the month then enter the pro-rata number. For instance,
if there are 30 dairy heifer replacements on the farm for just 2 weeks then enter the number 15
which is the pro-rata average number for the month (30 x 2/4 = 15); this is equivalent to having
15 heifers for the whole month. For pigs and poultry (except ostriches), where there are usually
several ‘batches’ of livestock produced in a year, enter the number of ‘places’ on the holding.

4. Estimate the % Occupancy of the livestock during the month. This is the percentage of the
excreta production that is collected for storage as slurry or solid manure — the remaining excreta
may be deposited at grazing. Edit the default values if appropriate. The entry in the column
"%Collected to slurry’ splits this quantity of excreta into storage as slurry or solid manure.

For pigs and poultry, estimate the percentage of the available livestock places that are occupied
during the month allowing for washdown time, etc.
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For grazing animals, estimate the percentage of the excreta that is deposited within the housing
and collection yards (i.e. excluding excreta deposited during grazing). You can edit the default
value if it is incorrect.

5. Use the drop-down list to change the default Manure system if it is incorrect (e.g. Free range is
available here for poultry layers).

6. Estimate the % Collected to slurry. This estimates the percentage of the excreta collected for
storage that is put into store as slurry including liquid excreta draining from manure stored on an
impermeable surface. The balance of the collected excreta will be mixed with bedding and
handled as solid manure. For instance, if all the collected excreta is to be stored as slurry, the
percentage will be 100%. Edit the default values if appropriate.

When estimating this percentage to calculate the NVZ minimum storage requirement, all of the
material going into a weeping wall or strainer box store should be counted as slurry.

Do not allow here for slurry that is separated using a mechanical separator. Enter this in a later
column on this screen.

7. For housing systems that include bedding, a Bedding factor is used to calculate the quantity of
solid manure produced (e.g. FYM). You can edit the default value if it is incorrect.

8. The total quantity of Bedding t/month used during the month is automatically calculated. You
cannot edit this value. If this value is incorrect, then you should alter the % excreta to slurry
and/or the bedding factor until the total quantity of bedding used during the month is more
accurate.

9. Tick the Mech separation box if some of the collected slurry always goes through a mechanical
separator that removes solids from slurry. These separators commonly reduce the slurry volume
by 5-10% (pigs) or 15-20% (cattle).

10. If you have ticked Mech separation, enter the % Slurry separated. This is the percentage of the
slurry collected that goes through the mechanical separator(s). You can edit the default value if it
is incorrect. PLANET will automatically calculate the amount of solids separated from the slurry.

11. Repeat steps 1 to 10 for each livestock type on the farm during each month of the inventory. You
can either enter these details manually for each month, or use the Data Entry Wizard. This
Wizard will copy selected information from a source month in Livestock Details to selected
destination months. See below for further details.

12. To delete a row of information, highlight the row by clicking on the small cell at the far left hand
end of the row then press the Delete key. If you hold down the Control key, you can select
multiple rows. To clear all the information on this tab (screen), click the right mouse button and
select Clear this tab. To clear information on all the tabs (screens) in this module select Clear all
tabs.

13. When you have entered all the required details for all relevant months, click on the Wash Water
tab.
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Data Entry Wizard

The Data Entry Wizard provides a quick and simple method for copying selected information that has
already been entered into Livestock Details for one month, to one or more other months in the
Livestock Details and/or Wash Water tabs.

PLANET PLANET

s W] o) o bt et e < o e s st s
in Livestock Detais, to other months n the Livestack Detals and/or Wash Water tahs

0l e eton o gy hat you spec s be e sane incech o e cesnan e o
that vou will edit [where needed] after copying has been caried out. For instance, values for livestoc

e she Livestack Detais tab Wash'Water tab
et e o Dl e, (0 e TR, e D1y RS (o] SeHEs A S R o
SiEssee e v st

Copy information to:

Select data items to copy Select data items to copy
Select source month in the Livestock Dietails tab
Livestock group Livestack group
Month October v Livestack type Livestock type:
Murnber Nurnber

Select destination months Manure system

October [ &l

Oecupanc
Mo ] May 4] Deeupancy
Etsdie | die Collected as slumy
Jaruary Fl Bedding factor
February [ August Mechanical separation
March [] September Slurry separation

1. Select the Data Entry Wizard ﬁ
2. Select the ‘source’ month from the drop-down list, and the ‘destination’ months. Click Next.

3. Select where you want the source month information to be copied to (Livestock Details and/or
Wash Water tabs), and the data items to copy. Click Finish.

4. Once information has been copied to the selected destination months, you must check and
edit each item of information to make sure that it is correct for the specific month.

At any time you can export all of the information you have entered in this grid to an Excel
spreadsheet where you can carry out further manipulation of the data. To do this, click the right hand
mouse button and select Export this tab. All information in the grid will be exported to an Excel file
that will be saved in Documents/PLANET/Data.
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Wash Water tab

You will need to enter details for each month that you wish the inventory to cover. If you wish to
calculate an estimate of the NVZ minimum manure storage requirement then you must enter all
required details for October to March inclusive (for pigs and poultry), or October to February
inclusive (for other livestock).

To expand or collapse information for a month, select the + or — to the left of the month name. To
Expand all months or Collapse all months, click the right hand mouse button and select the
required option, or go to the Tools menu at the top of the page.
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1. For each Month, enter the details of all livestock on the farm where wash water is used in that
month. Always enter new information in the top row for the month and press the return key to
accept the row information.

2. Select the Livestock group and Livestock type for each type of livestock that you have on the
farm during the month. First select the appropriate Livestock group (e.g. cattle), then select the
Livestock type (e.g. 1 dairy cow, 6000-9000 litres milk yield).

3. Enter the average Number of each livestock type that are on the farm for the whole month. If
livestock are on the farm for only part of the month then enter the pro-rata number. For instance,
if there are 30 dairy heifer replacements on the farm for just 2 weeks then enter the number 15
which is the pro-rata average number for the month (30 x 2/4 = 15); this is equivalent to having
15 heifers for the whole month. For pigs and poultry, where there are usually several ‘batches’ of
livestock produced in a year, enter the number of ‘places’ on the holding.

4. For dairy cows only, select the Hose type from the drop-down list (Power hose or Without power
hose).

5. For dairy cows and pigs, you can edit the Daily volume or Number of wash days.

6. For poultry only, after selecting the Livestock type from the drop-down list, enter the total Floor
area of all building(s) that are washed during the month.
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7. The Monthly volume of wash water used will be shown automatically for dairy cows, all pigs and
most poultry. You can edit this value if you have more specific information (e.g. a water meter).
For other livestock types, you can enter a monthly volume.

8. Select the Destination of the wash water from the drop-down list (i.e. storage in a Dirty water
store, Cattle slurry store, or Pig slurry store).

9. Repeat steps 1 to 7 for each livestock type on the farm during each month of the inventory. You
can either enter these details manually for each month, or use the Data Entry Wizard. This
Wizard will copy selected information from a source month in Livestock Details to selected
destination months.

10. To delete a row of information, highlight the row by clicking on the small cell at the far left hand
end of the row then press the Delete key. If you hold down the Control key, you can select
multiple rows. To clear all the information on this tab (screen), click the right hand mouse button
and select Clear this tab. To clear information on all the tabs (screens) in this module select
Clear all tabs.

11. When you have entered all the required details, click on the Imports and Exports tab.

At any time you can export all of the information you have entered in this grid to an Excel
spreadsheet where you can carry out further manipulation of the data. To do this, click the right hand
mouse button and select Export this tab. All information in the grid will be exported to an Excel file
that will be saved in Documents/PLANET/Data.
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Imports and Exports tab

You will need to enter details for each month that you wish the inventory to cover. If you wish to
calculate an estimate of the NVZ minimum manure storage requirement then you must enter all
required details for October to March inclusive (for pigs and poultry), or October to February inclusive
(for other livestock).

To expand or collapse information for a month, select the + or — to the left of the month name. To
Expand all months or Collapse all months, click the right hand mouse button and select the
required option, or go to the Tools menu at the top of the page.

[ﬂ PLANET - Organic Manures Inventory and Storage from October 2010 El@gl
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For each Month, enter details of the organic manures that are always imported onto the farm, or
always exported to your own land that is not in an NVZ, or to another farm. Always enter new
information in the top row for the month and press the return key to accept the row information.

Select import or export from the Import/Export drop-down list.
Select or enter the date of import or export.
Select the Manure type from the drop-down list.

Enter the Quantity of the manure type that is imported or exported.

o oA w N

The Dry matter, N, P.0s and K:0 contents of the manure type will be generated automatically.
You can edit any of these values if you have more specific information (e.g. laboratory analysis).
For manure type Other, you must enter these values.

N

For imports, select the Imports destination from the drop-down list.
For exports, select the Exports destination from the drop-down list.

Click in the Supplier/Recipient cell and enter details of the supplier of imported manure or the
recipient of exported manure. You can copy and paste information from one Comments box to
another using Control C (copy) and then Control V (paste).
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10. Repeat steps 1 to 9 for each type of manure that is imported or exported in each month of the
assessment period.

11. To delete a row of information, highlight the row by clicking on the small cell at the far left hand
end of the row then press the Delete key. If you hold down the Control key, you can select
multiple rows. To clear all the information on this tab (screen), click the right hand mouse button
and select Clear this tab. To clear information on all the tabs (screens) in this module select
Clear all tabs.

12. When you have entered all the required details, click on the Inventory tab. If you haven'’t already
saved your data, you will be asked to ‘Save the changes’.

At any time you can export all of the information you have entered in this grid to an Excel spreadsheet
where you can carry out further manipulation of the data. To do this, click the right hand mouse button
and select Export this tab. All information in the grid will be exported to an Excel file that will be saved
in Documents/PLANET/Data.
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Inventory tab

The Inventory tab shows calculated values based on the information that has been entered. It shows
Manure quantities or Nutrients. The calculation may take a short time before the inventory values

appear.

To expand or collapse information for a month, select the + or — to the left of the month name. To
Expand all months or Collapse all months, click the right hand mouse button and select the

required option, or go to the Tools menu at the top of the page.

[ PLANET - Organic Manures Inventory and Storage from October 2010 El@gl
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1. Use the drop-down lists to select the start and end Months that you want the inventory to cover.

-
Lol S T
2

2. Select the source categories you want to Show information for. Tick all those you want (cattle,
pigs, poultry, sheep/other, imports, exports, rainfall).

3. Select either Manure quantities or Nutrients.

If you select Manure quantities, the screen will show the estimated quantities of slurry, dirty
water, poultry layer manure, poultry litter and other solid manures (e.g. FYM) produced in

each of the selected months for each of the selected sources. Wash water will be included as
slurry or dirty water depending on where it is stored. Clean rainfall is rainfall that can often be

redirected as drainage (e.g. from roofs, uncovered slurry or dirty water stores, and clean
concrete); dirty rainfall is rainfall falling on uncovered solid manure stores or dirty concrete

areas that may not be easily redirected. Quantities of imports (to store and to land combined)

and exports will be shown.

If you have a weeping wall or strainer box type system, the estimated quantities are for the
material that goes into store. Depending on the effectiveness of the slurry separation, some

of the material coming out of store may be classed as solid manure under the NVZ rules, if it

can be stacked in a freestanding heap without slumping, and does not drain liquid from the

stacked material.
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If you select Nutrients, the screen will show an estimate of the quantity of crop available
nitrogen (N), total phosphate (P,0s) and total potash (K>O), and an estimate of their financial
value based on the nutrient prices entered in the Manure Stores Tab.
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At any time you can export all of the information you have entered in this grid to an Excel
spreadsheet where you can carry out further manipulation of the data. To do this, click the right hand
mouse button and select Export this tab. All information in the grid will be exported to an Excel file
that will be saved in Documents/PLANET/Data.
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NVZ Minimum Storage tab

This tab calculates an estimate of the NVZ minimum storage capacity. You cannot enter any

information in this tab.

[ﬂPLAN[T - Organic Manures Inventory and Storage from October 2010
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The NYZ Action Programme requires that there is a minimum storage capacity reguirement for livestock slurries and poultry manures.

The minirurm storage capacity for slurey must include the volurme of slurry collected and any dilution water such as wash water and rainfall that is collected in the slurry store during
Qrtoher to March (ig or poultry slurry) or Octoher to February (cattle/other livestock slurnd, allowing for exponts of slurry.

The minirmurm storage requirement for poultry manure is 6 months production (October to March), allowing for irmports and exports.

For further information see the relevant MvZ guidance leaflet(s)

Catlerother shiry Pigsmy  Rainfallto sluny stares Poulty layet manure Pouity ftter
(] ) () 2] [tonres]
Detaber 3 650 112 0 7
November =] &80 108 0 ]
December 53 650 % 0 %
January 53 650 33 0 %
February 363 £50 72 0 %
March ES0 a8 o 58
Starage facilly in an NVZ Yes Yes Yes Yes Yes
Total 1,765 3,900 575 0 563
Total NVZ minimum siuny storage requirement 2400 w
Total NYZ minirwm pauliy manure storage requiement 563 t Mz m
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Report

To view and print a report, select the report icon from the task bar at the top of the screen. The
report includes details of the information that has been entered, estimates of the manure quantities
from different sources and their financial value, and an estimate of the NVZ minimum storage
capacity requirement. Further details can be found in the NVZ Booklet 5 ‘Manure Planning 2:
Livestock Manure Storage’.

To return to other modules in PLANET select the required icon from the task bar or use the ‘View’
menu.
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